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1 Introduction

settling grounds for human population as they provided

abundant marine resources, fertile agricultural land
and possibilities for trade and transport. This has led to high
population densities and high levels of development in many
coastal areas and this trend is continuing into the 21t century.
Currently about 1.2 billion people live in coastal areas globally
and this number is predicted to increase to 1.8-5.2 billion by
the 2080s due to a combination of population growth and
coastal migration (IPCC 2007b; Small and Nicholls 2003).
This will be followed by major investments in infrastructure
and in the built environment.

S ince early civilisation, coastal areas have been attractive

The character of coastal environments, however, poses some
great challenges to human habitation. Coastlines are highly
dynamic natural systems that interact with terrestrial, marine
and atmospheric processes and undergo continuous change
in response to these processes. Over the years, human
society has to a great extent failed to recognize this dynamic
character of coastal areas, and this has led to major disasters
and societal disruption of various degree. Even today, coastal
development is often taking place with little regard to natural
dynamics, and this problem is especially pronounced in
developing countries where data, technical expertise and
economic resources are limited and coastal populations are
growing rapidly.

The predicted climate change adds an extra risk factor

to human activities in coastal areas. While the natural
dynamics that shape our coasts have been relatively stable
and predictable over the last centuries, much more rapid
change is now expected in processes as sea level rise,
ocean temperature, ocean acidity, tropical storm intensity
and precipitation/runoff patterns (IPCC 2013). The world’s
coastlines will respond to these changes in different ways
and at different pace depending on their bio-geophysical
characteristics, but generally society will have to recognize
that past coastal trends cannot be directly projected

into the future. Instead, it is necessary to consider how
different coastal environments will respond to the predicted
climate change and identify relevant management options.
Furthermore, improved coastal communication is essential for
development of management strategies within the broader
framework of Integrated Coastal Zone Management (ICZM).

The Coastal Hazard Wheel (CHW) is an information and
decision-support system developed to address these
challenges. It can be used for multi-hazard-assessments,
for identification of relevant management options for a
specific coastline and as a standardized coastal language
to communicate coastal information. It can be applied in

NTEZSUCTION

areas with limited data availability and technical capacity and
can therefore be used in both developed and developing
countries. Since the CHW incorporates climate change
effects in the hazard evaluations, it is especially suited

for climate change adaptation. Furthermore, it is suited

for Disaster Risk Reduction under the Sendai Framework
(UNISDR 2016) and can support Source-to-Sea governance.

The CHW is designed to support coastal decision-making
and information exchange at local, regional and national

level and covers all the main coastal hazards, including
ecosystem disruption, gradual inundation, salt water intrusion,
erosion and flooding. It is developed as a universal coastal
classification system that contains 131 generic coastal
environments and a total of 655 individual hazard evaluations.
The initial version of the system was presented in 2012 and
based on assessments for the Indian State of Karnataka,

the Republic of Djibouti, a great number of local assessments
and feedback from coastal experts, the system has been
refined to a CHW 3.0 and a standardized application
procedure has been developed. The CHW 3.0 presented

in this publication is in most aspects similar to the CHW 2.0
presented in Rosendahl Appelquist and Halsnaes (2015) but
due to some minor procedural changes it has been labelled
3.0 to ensure clarity.

This publication package aims to provide a complete guide
to the use of the CHW for coastal decision-support and
communication worldwide. The Quick start guide provides a
brief introduction on how to use the CHW for coastal decision-
making and information exchange. This Main manual and the
accompanying Catalogue of hazard management options
provide more detailed instructions on the use of the CHW
and the technical background for the different management
options. Generally, the CHW is well-suited for facilitating
communication and information exchange between different
management levels, scientists and policy-makers, as the
CHW codes can be easily communicated and interpreted.

The publication is based on the scientific background papers
on the CHW and further details can be found in these papers
(Rosendahl Appelquist and Halsnaes 2015; Rosendahl
Appelquist and Balstrgm 2015; Rosendahl Appelquist and
Balstram 2014; Rosendahl Appelquist 2013). The CHW 3.0

is shown in Fig 1 and is used by starting in the wheel centre,
moving outwards through the coastal classification and
ending with the hazard evaluations and coastal classification
codes in the outermost circles.
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Fig. 1. The Coastal Hazard Wheel 3.0 consisting of six coastal classification circles, five hazard
circles and the coastal classification codes. It is used by starting in the wheel centre moving
outwards through the coastal classification (modified from Rosendahl Appelquist and Halsnaes
2015 and Rosendahl Appelquist 2013).
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2 The CHW and the universal coastal classification system

THE CHW AND
THE UNIVERSAL
COASTAL
CLASSIFICATION

SYSTEM

have been developed to assess and manage coastal

vulnerability and climate-related hazards. Generally,
one can distinguish between index based methods, indicator
based methods, GIS-based decision support systems and
dynamic computer models that are developed for different
purposes and with different requirements for data and
expertise (Ramieri et al. 2011).

T o date, several different methodologies and approaches

Index based methods are the most simple to use, can be
applied at various scales and are useful for screening
assessments and for supporting the identification of
vulnerable coastal areas. However, they do not provide
information on the range of different hazards to a coastal
location, require elaboration of assumptions to avoid a black-
box effect, need relatively detailed input data and cannot be
used directly to identify management strategies. Indicator
based methods allow for a greater sector-specific detail
while remaining relatively simple but still require a significant
level of input data and technical expertise. Both GIS based
decision-support systems and dynamic computer models are
very advanced systems that can incorporate large amounts
of data and variables and can be used for both single- and
multi-sector assessments and for design purposes. However,
these systems require significant amounts of data, technical
expertise and operational resources and are therefore difficult
to use directly for coastal managers and decision-makers.

Compared to the existing systems, the CHW is developed as
a multi-tool that can address the key coastal management
issues collectively and is directly accessible for coastal
decision-makers at all management levels. The CHW is
therefore well-suited as a general information and
decision-support system that can be supplemented with other
available methods and models when considered appropriate.

The universal coastal classification system constitutes the
foundation for the CHW and is developed particularly for
decision-support. The system is based on the
bio-geophysical parameters that are considered most
important for the character of a particular coastal environment
and the parameters included are geological layout,

wave exposure, tidal range, flora/fauna, sediment balance
and storm climate. In order to avoid a disproportionate
large number of categories, the system applies an “Any”
phrase in cases where a particular classification parameter
is of minor importance and variables such as local isostatic
uplift/subsidence and sediment grain size are not directly
included as they to some extent are covered through the
other parameters.

Since the bio-geophysical variables can change significantly
over short spatial distances, a generic coastal environment
will according to the classification system theoretically
apply to a particular spot along a coastline. For practical
application, however, a single application of the CHW will
apply to a coastal stretch of ca. 200-300 meter coastline
and larger regional and national assessments consist of e.g.
hundreds of individual sections classified with the CHW.

In some areas, the same coastal type may extend for many
kilometres while in others it changes every few hundred
meters. Often there is a gradual transition between the
different coastal environments and hence it is up to the user
to make the best possible judgement on the appropriate
coastal classification. This can lead to some inaccuracies
but is considered an unavoidable precondition for using

the system.

Human alterations of the coastline may affect the coastal
characteristics and hazard profile but since it is very difficult
to determine the effect of a particular alteration or hazard
management measure, the classification of a coastal site
should reflect the generic “coastal environment”.
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Human modifications of the coastal layout should
therefore only be considered if they can be seen as a
permanent modification of the “coastal environment”.

This core classification can then be supplemented with
information on relevant human activities and management
measures as described in chapter 6 on application of the
CHW as a standardized coastal language.The different
classification components have been clearly defined in

2.1. GEOLOGICAL LAYOUT

The geological layout constitutes the basis on which the
dynamic processes act and has been created by various past
dynamic processes including glacial, fluvial, marine, volcanic
and tectonic (Davis and Fitzgerald 2004). The coastal
landscape continues to be modified by these processes

over different timescales and making an assessment of a
particular geological layout will therefore be a snapshot that
will change gradually over time. However, as most major
changes in geological layout take place on timescales

of decades or more, the effect of these changes on the
classification is limited. Furthermore, the subsequent layers in
the classification system include the major short-term coastal
processes, meaning that most gradual natural changes are
handled by the system.

The geological layouts included in the classification system
are defined based on a thorough analysis of the world’s
costal environments and are framed in a way so they cover
all major types of geological layouts worldwide. They are
defined to include important generic characteristics while still
maintaining an appropriate simplicity. The geological layout
categories included in the CHW 3.0 are sedimentary plain;
barrier, delta/low estuary island; sloping soft rock coast,

flat hard rock coast; sloping hard rock coast; coral island,
tidal inlet/sand spit/river mouth. The first four categories are
sedimentary geological layouts generally found on trailing
edge coastlines' such as the Atlantic coast of North- and
South America, whereas the sloping hard rock coast is
commonly found on leading edge coastlines? such as the
Pacific coast of North and South America. The flat hard rock
coast can appear in various settings such as raised coral
reefs, whereas the coral island category is largely depending
on tectonic and climatic conditions (Davis and Fitzgerald
2004; Masselink and Hughes 2003). The final category tidal
inlet/sand spit/river mouth constitutes a group of special
dynamic geologic environments.

In many coastal locations, there is a gradual transition
between related geological layouts, e.g. between barriers
and delta/low estuary islands and in these cases it is up to
the user to decide on the most appropriate layout category.
Table 1 provides an overview of the key characteristics of
the different geological layout categories, which are further
elaborated below.

' Trailing edge coasts occur where tectonic plates rift apart,
creating a wider continental shelf.

2 Leading edge coasts occur where a continental plate converges
with an oceanic plate, creating a narrow continental shelf and a
mountainous coastline.

MANAGING CLIMATE CHANGE HAZARDS IN COASTAL AREAS - MAIN MANUAL

order to differentiate the generic coastal environments and
the definitions and data requirements for the classification
components are further described below. Depending on the
data availability and accuracy requirements, the CHW can be
applied at three different classification steps and information
on the data requirements for the different steps is included in
the sections below and further covered in chapter 4 on local,
regional and national multi-hazard-assessments.

Low-lying coast Sloping coast

Sedimentary plain

Barrier
Sedimentary/soft Delta/low Sloping soft
rock material estuary island rock coast
Tidal inlet/sand
spit/river mouth
Hard Flat hard Sloping hard
rock material rock coast rock coast
Mixed Coral island

Table 1. Key characteristics of the different geological
layout categories.

The sedimentary plain category is defined as coasts with an
average elevation of less than 6-8 meters 500 meter inland

of the Mean Sea Level (MSL), and which are composed of
sedimentary deposits such as clay, silt, sand, gravel, till or
larger cobbles. If coastal dunes are present, the elevation
may locally be higher at the dune peaks, but the coast will still
fall into the sedimentary plain category. Sedimentary plains
are often formed by glacial and fluvial processes or through
coastal progradation® (Davis and Fitzgerald 2004; Masselink
and Hughes 2003).

The barrier category is defined as coasts that consist of
non-sloping/low-lying, shore parallel sedimentary bodies
with cross distances ranging from less than 100 meters to
several kilometres, and lengths ranging from less than 100
meters to over 100 kilometres (Davis and Fitzgerald 2004).
Narrow barriers often exist where the sediment supply

is or has been limited while broad barriers are formed in
areas with sediment abundance (Masselink and Hughes
2003). The seaward side of a barrier often contains a wave
dominated beach environment, while the landward side
consists of protected lagoons and estuaries with various
kinds of marsh or mangrove vegetation depending on climatic
conditions and tidal range. In meso-tidal and macro-tidal
environments, barriers are frequently cut by tidal inlets.

In the classification system, a barrier can occur in parallel to
coastlines of other geological layouts, located landwards of

3 Coastal progradation is the seaward advance of a coastline due to
sediment accumulation or sea level fall.
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the barrier. This would e.g. be the case where a sedimentary

plain or sloping soft rock coast is located landwards of a

barrier. Barriers may occur as part of a delta and in that case

-

TIDAL FLATS
FLOOD TIDAL DELTA AT
NI BNy

MARSH ] i

e

LAGOON

BARRIER BEACH COMPLEX

SHOREFACE

The delta/low estuary island category is defined as coasts
composed of fluvial transported sediment that is deposited
in front of a river mouth. These landforms form in the
coastal-fluvial interface where riverine sediment supplied
to the coastline is not removed by marine processes.

The formation of deltas/low estuary islands is therefore
strongly dependent on the fluvial sediment discharge as well
as the waves, tides and currents of a particular location.
Plate tectonics and regional geological conditions also
influence delta formation. Larger deltas are generally found
on trailing edge and marginal sea coastlines* where large
drainage basins provide a high fluvial discharge and wide
continental shelves provide a relatively shallow depositional

the most appropriate categorisation would be the delta/low
estuary island category (described below).

MAIN TIDAL CHANNEL (INLET)
_.-'

4B EBB TIDAL DELTA

B SECONDARY TIDAL CHANNEL

Fig. 2. Barrier system with
outer beach environment
and protected
backbarrier environment
(From: Reinson 1984.
Copyright ©1984,
Geological Association

of Canada).

area (Schwartz 2005). Examples of major deltas developed
under these conditions are the Mississippi and Amazon
deltas in the Atlantic Ocean and the Yangtze delta in

the South China Sea (Davis and Fitzgerald 2004). Small
deltas might form along leading edge coastlines but their
extension is limited by the smaller drainage basins and steep
coastal gradient that does not allow for significant sediment
accumulation. Fig 3 provides an overview of the broad
variety of delta formations and all light blue areas of the delta
illustrations will in the CHW classification system fall into the
deltas/low estuary islands category. It is important to note,
however, that sloping estuary coastlines do not fall into the
delta/low estuary island category.

GEOLOGICAL
LAYOUT CATEGORIES

The geological layouts included in
the classification system are framed
so they cover all major types of
geological layouts worldwide.

4 Marginal sea coastlines occur where tectonic plate convergence
takes place offshore and these coasts have a relatively wide
continental shelf.

In many coastal locations
there is a gradual transition
between related geological
layouts and in these cases it is up
to the user to decide on the most
appropriate layout category.
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The sloping soft rock coast category is defined as coasts
comprised of soft rock material with an average elevation

of more than 6-8 meters 500 meter inland of the MSL.
Sloping soft rock coasts can be comprised of a range of
different sedimentary deposits such as chalk, moderately
cemented laterite, clay, silt, sand and till with larger pebbles
or cobbles. Their geological origin can range from old
uplifted seabed to more recent glacial deposits (Schwartz
2005). Hard sedimentary rocks are not included in this
category and it can therefore be necessary to assess the
level of sediment cementation in order to determine whether
a particular coast should be classified as soft or hard rock.

In the classification system, a rock will fall into the soft rock
category if the sediment is poorly cemented and as a general
rule, it should be possible to push a knife some centimetres
into the rock material without using excessive force. However,
assessing this in the field is not always straightforward as
hard rock material may be covered by a layer of sediments.
The recommended approach is therefore to make use

of a basic geologic map, if possible combined with field
observations. Sloping soft rock coasts can both be present as
coastal cliffs and vegetated hills.

The flat hard rock coast category is defined as coasts
consisting of igneous, sedimentary and metamorphic rock
with an average elevation of less than 6-8 meters 500 meter
inland of the MSL. Igneous rocks are formed from magma

MANAGING CLIMATE CHANGE HAZARDS IN COASTAL AREAS - MAIN MANUAL 6
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Physical Environment
3ed, Peter Smithson,
Ken Addison & Ken
Atkinson, Copyright
©2002 Routledge,
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Francis Books UK).

and are comprised of a range of different minerals and

grain sizes depending on their chemical composition and
solidification process. Sedimentary rocks consist of sediment
that has undergone different stages of diagenesis, where
the sediment has been compacted and cemented under
increased temperature and pressure, creating a solid

rock structure. Metamorphic rocks have formed from both
igneous and sedimentary rocks when they have undergone
recrystallization under high temperature and pressure (Press
and Siever 2001). The specific physical and chemical rock
properties influence the weathering and erosion processes,
but for the coastal classification system, hard rock material
is considered as one uniform group. Flat hard rock coasts
can be present in different forms such as rocky coastal
plains, islands and archipelagos and the hard rock can
sometimes be partly hidden by a layer of weathered rock/
loose sediments.

The sloping hard rock coast category is defined as coasts
consisting of igneous, sedimentary or metamorphic rock
with an average elevation of more than 6-8 meters 500 meter
inland of the MSL. Sloping hard rock coasts can be present
in different forms such as coastal mountain chains, hills,
headlands, islands and archipelagos and the hard rock can
sometimes be partly hidden by a layer of weathered rock/
loose sediments.




2 The CHW and the universal coastal classification system

The coral island category is defined as low-lying coral islands
in the form of tropical atolls and coral cays. Tropical atolls are
open ocean coral islands that rest on a subsiding volcanic
foundation. The coral base can be as old as 30 million years
and reef material can be found at depths of over 1000 meters
beneath the atoll. Atolls have a round shape with diameters
ranging from a few kilometres to more than hundred
(Schwartz 2005). Coral cays are younger islands formed on
top of coral reefs or adjacent to atolls due to the accumulation
of reef-derived sediment in one location as a result of wave
action. These islands can rise up to three meters above high
water level and can be composed of coarse reef fragments
or fine carbonate sand. The beaches of both atolls and

coral cays can have cemented to form beachrock and coral
sandstone that help stabilize the islands (Haslett 2009).

The tidal inlet/sand spit/river mouth category is established
as a separate grouping in the classification system as these
environments can be highly morphologically active and
respond quickly to changes in other coastal processes
(Mangor 2004). In the classification system, tidal inlets are
defined as the coastline of a tidal inlet itself and one kilometre
parallel to the shore on each side of the inlet. Tidal inlets

are found along barrier coastlines throughout the world

and provide water exchange between an open coast and
adjacent lagoons and estuaries. Their morphology depend
on a range of different parameters such as tidal range,

wave climate and sediment availability (Davis and Fitzgerald
2004). In special cases, where the tidal inlet side consists

of a hard rock headland, the inlet side should fall into one of
the hard rock categories. Sand spits are defined as elongate
sedimentary deposits that are formed from longshore currents
losing their transport capacity and subsequently depositing
sediment at particular locations. They can be present in
different shapes and are generally classified into simple
linear spits, recurved spits with hook-like appearances,

and complex spits with plural hooks (Schwartz 2005). River
mouths are defined as the coastline one kilometre on each
side of a well-defined river mouth. Tidal inlets, sand spits

and river mouths are assigned high priority in the CHW
classification system, meaning that e.g. a sedimentary plain
will fall into this category if it is located less than one kilometre
on each side of a river mouth.

2.2. WAVE EXPOSURE

The wave exposure is the dominant energy source in the
nearshore environment and a highly important parameter

for the coastal morphodynamics. Although some incoming
wave energy is reflected by the shoreline, most energy is
transformed to generate nearshore currents and sediment
transport and is a key driver of morphological change
(Masselink and Hughes 2003). The wave height is the
generally applied measure for incoming wave energy and is
defined as the difference in elevation between the wave crest
and wave trough (Davis and Fitzgerald 2004). Since the wave
energy increases as the square of the wave height, coastal
environments with high wave heights have a relatively high
energy intensity compared to coasts with lower wave heights
(Thieler et al. 2000).

Data requirements for determining the
geological layout

The core data requirements for classifying the geological
layout at step 1 are a basic geologic map of the assessment
area, Google Earth’s satellite images and Google Earth’s
terrain elevation function.

The classification of the geological layout is done by combing
information from these three data sources, and the geological
map is used to assess whether the coastline is composed

of soft or hard rock material, Google Earth’s satellite images
are used to get an overview of the coastal outline and identify
form-features as barriers, deltas, tidal inlets, sand spits, river
mouths and islands, and Google Earth’s terrain elevation
function and ruler is used to assess whether the coastline has
a flat or sloping character (the elevation values are shown

in the button of the Google Earth window when the cursor

is hovered over the coastline ). One should be particularly
aware that Google Earth’s elevation numbers can be affected
by dense vegetation and buildings which can lead to
overestimated elevation numbers for some areas. This can
necessitate supplementary elevation data e.g. from advanced
elevation surveys, local topographic maps, communication
with local contacts or judgements based on landforms.

For a step 2 classification, the data should be supplemented
by representative field verification e.g. in areas where there
are doubts about the geological base material or elevation.
A step 3 classification would require additional high quality
data on coastal geology and elevation.

To support the classification of continues coastal stretches
especially at step 1-2, it is recommended to draw a shore-
parallel line-feature in Google Earth, landwards of the
coastline in all areas with an elevation over 6-8 meter

500 meter inland of the MSL. This can be done using Google
Earth’s New Path function and should be reassessed for every
200-300 meter coastline. In this way, sloping coastal sections
can be easily identified during subsequent implementation

of manual multi-hazard-assessments in ArcGIS (described
further in chapter 4).

Gravity waves generated by wind stress on the ocean surface
constitute the main type of waves affecting coastal systems.
The restoring force for this wave type is earth’s gravity and
gravity waves are generally composed of sea- and swell
waves (Masselink and Hughes 2003). Sea waves are formed
under direct influence of the wind on the ocean surface

and have peaked crests and broad troughs. They are often
complicated with multiple superimposed sets of different
wave sizes and whitecaps can be present during high wind
speeds. Swell waves develop when the wind stops and
when the waves travel outside the area where the wind is
blowing. They have a sinusoidal shape and commonly have
long wavelengths and small wave heights (Masselink and
Hughes 2003). Whether a coast is primarily affected by sea
or swell waves is largely determined by the general climatic
conditions and coastline geography.

MANAGING CLIMATE CHANGE HAZARDS IN COASTAL AREAS - MAIN MANUAL




The CHW applies a wave environment perspective and
distinguishes between exposed, moderately exposed and
protected coastlines based on the wave height. The simplified
way of estimating the wave exposure makes use of
information on the general wave climate, the waterbody size

1)

The general wave climate of an area is determined based
on Fig 4. All coastlines falling into “West coast swell”,
“East coast swell” and “Trade/monsoon influences” are
classified as swell wave climates, while the remaining
types are classified as non-swell wave climates.

(fetch length) and the wind conditions and is done through

the following process: 2) The specific exposure level for a coastal site is

determined based on Table 2.
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Fig. 4. Global wave

Wave environments environments (Davies

[ ] Storm wave [ # | West coast swell ;98/\9]’ moijﬁked d
[ ] Tropical cyclone influences | = | East coast swell H):Ighéiezsgér(SSilr/; d
Sheltered area 7 | Trade/monsoon influences Rosendahl Appelquist).

General wave climate Waterbody size Specific coastal conditions CHW classification

(fetch length)

Swell wave climate Any
(West coast swell,

East coast swell, Trade/
monsoon influences)

Extreme swell (West coast swell south of 30°S) Exposed

Swell Moderately exposed

Backbarrier, inner waters, inner estuary, fjord Protected
Non-swell wave climate > 100 km Stronger on-shore winds Exposed
Storm wave, Tropical )
E:yclone influenc:s, Weak on-shore winds Moderately exposed
Sheltered area) .
10 - 100 km Stronger on-shore winds Moderately exposed
Weak on-shore winds Protected
< 10 km Any Protected

Table 2. Wave exposure classification for the CHW system.
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2 The CHW and the universal coastal classification system

If detailed wave data is available, including for inner waters,
the wave exposure should ideally be determined based

on the significant wave height occurring continuously for

12 hours per year, the Hs 12h/yr. In that case, a coastline
with a Hs 12h/yr > 3 m is classified as exposed, a Hs 12h/yr
= 1-3 m is classified as moderately exposed and a Hs 12h/yr
< 1is classified as protected. Using this procedure, however,
requires detailed wave data with a resolution in order of ~

1 km.

Data requirements for determining the
wave exposure

The core data requirements for classifying the wave exposure
at step 1-2 are Fig 4 and Table 2, Google Earth and basic
information on the local wind climate.

Areas with extreme swell can be identified using Fig 4 and the
latitude displayed in Google Earth. The waterbody size (fetch
length) can be determined using Google Earth’s satellite
images and ruler and should as far as possible take off-shore
archipelagos/reefs into account. The presence of weak
on-shore winds can be determined with basic knowledge

2.3. TIDAL RANGE

Tides can have major impact on shoreline processes

and on the development of coastal landforms. They are a
manifestation of the moon’s and sun’s gravitational force
acting on earth’s hydrosphere and are present in the form of
oceanic waves with wavelengths of thousands kilometres,
resulting in periodic fluctuations in coastal water levels
(Davis and Fitzgerald 2004). Tides fluctuate on a daily basis
following diurnal, semidiurnal and mixed tidal cycles (Davis
and Fitzgerald 2004). Diurnal tides exhibit one tidal cycle
daily whereas semidiurnal tides exhibits two cycles daily.
Mixed tides have components of both diurnal and semidiurnal
tides varying throughout the lunar cycle (Davis and Fitzgerald
2004). Globally, semidiurnal and mixed tides are dominating
coastal areas (Haslett 2009).

From a morphodynamic perspective, it is the tidal range that
significantly influences coastal processes and controls the
horizontal extent of the intertidal zone, the vertical distance
over which coastal processes operate and the area being
exposed and submerged during a tidal cycle (Haslett 2009).
The tidal range is defined as the height difference between
the high water and low water during a tidal cycle (Schwartz
2005) and the tidal range of a particular coastal location

is controlled by a range of different parameters including
the distance from an oceanic amphidromic point?, the local
bathymetry, the width of the continental shelf and the coastal
configuration (Haslett 2009). Generally, the tidal range
increases with distance from an amphidromic point, with a
bathymetric focus of the tidal wave on a particular coastal
stretch, with a shallow continental shelf and with a coastline
restriction as in the case of gulfs and estuaries (Haslett 2009).

5 An amphidromic point is the zero amplitude location for a
harmonic tidal wave.

of the regional wind climate and one should be particularly
aware of possible weak on-shore winds in regions
categorized as “Sheltered area” in Fig 4. Generally, the whole
“Sheltered area” of Southeast Asia can be considered as
having weak on-shore winds.

For islands not covered by Fig 4, one should try to obtain
local data on the presence of swell or non-swell wave
environments or data on the Hs 12h/yr. For ice affected
coastlines, the fetch length may fluctuate due to presence

of winter sea ice, but as sea ice is expected to be highly
vulnerable to climate change, the same approach as for ice-
free coasts should be used unless the ice is considered very
stable. The same exposure level may in some cases apply
to long coastal stretches, but can also apply to very short
stretches in locations with a diverse coastal configuration.

For a step 3 classification, detailed wave data is required in
order to determine the wave exposure based on the Hs 12h/yr.

The numerical value of the tidal range vary significantly
between coastal locations and span from almost zero to about
16 meters in funnel shaped embayments such as the Bay of
Fundy, Canada (Davis and Fitzgerald 2004). The tides of a
particular location also fluctuate on a daily basis depending
on planetary positions.

For classification purposes, coastlines can be grouped

into various tidal environments based on tidal range and a
generally used classification system operates with the three
main categories micro-tidal, meso-tidal and macro-tidal
(Schwartz 2005). Micro-tidal environments are defined as
coasts where the tidal range does not exceed 2 meters and
can be found on open ocean coastlines such as the southern
seaboard of Australia and the majority of the African Atlantic
coast (Haslett 2009). Meso-tidal environments are defined

as coasts with a tidal range of 2-4 meters and examples of
these are found on the Malaysian and Indonesian coasts and
on the eastern seaboard of Africa (Haslett 2009). Macro-tidal
environments are defined as coasts where the tidal range
exceeds 4 meters and examples of these are found on some
of the northwest-European coasts and in parts of north-
eastern North America (Haslett 2009). The global distribution
of micro-, meso- and macro-tidal environments is shown in
Fig 5.

The tidal range is defined as the
height difference between the high
water and low water during a tidal

cycle (Schwartz 2005).
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Tide range environments

[7] 2-4 m (meso)

B > 4 m (macro)

< 2 m (micro)

The effect of the tidal range on coastal morphodynamics is
largely controlled by the level of wave exposure. Therefore,
the relative size of tides and waves of a particular location

is - seen from a morphodynamic perspective - more important
than the magnitude of the tidal range itself (Masselink

and Hughes 2003). This relationship is illustrated by the
relative tidal range expression that states that the relative
morphodynamic importance of the tidal range decreases
with increasing wave exposure (Masselink and Hughes
2003). This principle is applied in the classification system
that uses the three different tidal categories, micro, meso/
macro and any that are applied in accordance with wave
exposure. Where the coastline is exposed or moderately
exposed, the classification uses the any tide category as
these environments are considered to be largely dominated
by wave processes. At protected coastlines, the tidal range
can have major impact on the coastal morphodynamics and
the classification system therefore distinguishes between
micro and meso/macro-tidal conditions. Under micro-tidal
conditions, these coastlines will still be partly wave dominated
whereas they will be largely tide dominated under meso/
macro-tidal conditions. The merging of meso/macro tides is
regarded as an acceptable simplification without significant
implications for a reliable hazard valuation except under
extreme high tidal range conditions. Since the effect of

tidal range on the characteristics and hazard profile of

2.4. FLORA/FAUNA

For some coastal environments, the flora/fauna constitutes
an important parameter for their characteristics and hazard
profile. In the CHW system, the flora/fauna has been
included where it is considered to play an important role

for the coastal characteristics. The integration of the flora/
fauna component in the classification system is complicated
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Fig. 5. Map over global
tidal environments
(Davies 1980, modified
by Masselink and
Hughes 2003).

sloping soft rock coasts, flat hard rock coasts, sloping hard
rock coasts and coral islands is considered to be minor,

the any tide category has been applied to these layouts

for simplification purposes. In the case of tidal inlets, tidal
forces play a key role for their morphodynamics, but these
environments are included in a separate category due to their
special properties.

Data requirements for determining the tidal range

The core data requirements for classifying the tidal range

at step 1-2 is the map in Fig 5 which is used to determine
whether the tidal range for a coastal location is of the micro or
meso/macro types. For a step 3 classification, supplementary
data on tidal range should be obtained e.g. in the form of tide
tables from commercial harbours. For islands not included in
Fig 5, one has to obtain local information on the tidal range for
a classification at any level.

The same tidal range category often applies to long coastal
stretches and once the tidal conditions are determined

for a particular area, it is relatively easy to go through this
classification layer in the CHW.

by its interdependence with other physical classification
parameters and this is reflected in the application of the flora/
fauna categories. In total, the classification system operates
with nine different categories namely intermittent marsh;
intermittent mangrove; marsh/tidal flat; mangrove/tidal flat;
marsh/mangrove; vegetated, not vegetated, coral and any.




2 The CHW and the universal coastal classification system

The intermittent marsh and marsh/tidal flat categories are
applied to coastlines whose geological layout falls into the
categories sedimentary plain, barrier and delta/low estuary
island. The marsh is a grass-like vegetation of salty and
brackish areas along protected, low energy coastlines.

It colonizes higher parts of the intertidal environment, forming
coastal wetlands that act as a sediment trap for fine grained
sediment. Marsh areas gradually build up from continuous
flooding and subsequent sediment deposition which can be

particularly large during storm events. Due to the continuous
accumulation of sediment, marsh areas can to some degree
follow sea level rise but will eventually drown if sea level rises
too rapidly. In locations with a high tidal range, marsh areas
are often continuous and combined with extensive tidal flats,
and the classification therefore distinguishes between the
intermittent marsh category applied to areas with micro-tidal
conditions and the marsh/tidal flat category applied to areas
with meso/macro-tides.

Mk S

The intermittent mangrove and mangrove/tidal flat categories
are applied to coastlines falling into the geological layout
categories sedimentary plain, barrier and delta/low estuary
island. Mangrove is a woody shrub vegetation that grows
along protected, low energy coastlines, forming a swampy
environment. It is very dependent on air temperature and
cannot tolerate a freeze and its geographical extension is
therefore limited to low and moderate latitudes. The extensive
root network of mangroves acts as an efficient trap for fine
grained sediment and reduces wave erosion of the coastline.
Like marsh areas, mangrove forests are rich ecosystems

Fig. 6. Marsh vegetation
in Denmark.

that provide nursing grounds for many animals and in
addition limit erosion and flooding from tropical storms. In the
classification system, the intermittent mangrove category

is applied to areas with micro-tidal conditions, while the
mangrove/tidal flat category is applied to areas with meso/
macro-tides (although mangroves often colonize most of
the tidal flats). The combined marsh/mangrove category is
applied to protected, flat hard rock coasts that have a band
of marsh/mangrove vegetation. If a sloping hard rock coast
has a significant band of marsh/mangrove vegetation, it will
automatically fall into the flat hard rock category.

Fig. 7. Mangrove
vegetation in Australia.
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The vegetated and not vegetated categories are applied to
the geological layout category sloping soft rock coast where
vegetation of the coastal slopes plays an important role for
the coastline characteristics and determines whether it can
be considered a coastal cliff. The vegetated category is
applied when more than 25% of the initial coastal slope is
covered with vegetation while the not vegetated category

is used when less than 25% of the initial slope is vegetated.
Possible vegetation includes different grasses, scrubs and
trees depending on the soft rock properties, slope and
climatic conditions. Although some types of vegetation have a
better stabilizing effect than others, the important criteria from
a coastal classification perspective is whether the coastal
slope is vegetated or not. Sloping soft rock coasts may be
fronted by a narrow band of marsh or mangrove vegetation
but this is not considered of major importance from a coastal
classification perspective. In cases where the fronting marsh
or mangrove areas are more extensive, the coastline will
automatically fall into one of the non-sloping geological
layout categories.

The coral category is only available for flat hard rock coasts
and sloping hard rock coasts where the corals have a hard

substrate to thrive on. Corals are carnivorous suspension
feeders, living in large colonies as polyps with an external
skeleton of calcium carbonate (Masselink and Hughes
2003). Since they generally attach to hard substrates, rocky
shorelines provide suitable coral habitats (Masselink and
Hughes 2003). Reef building coral species only thrive in
water temperatures between 18°C and 34°C and are thus
limited to tropical and subtropical environments (Davis

and Fitzgerald 2004). Reef building corals are very light
sensitive and reefs are rarely being created at depths greater
than 50 meters. Locally, water turbidity and salinity can be
important parameters for reef formation, and high turbidity
can decrease light penetration and increase sedimentation,
thereby inhibiting coral growth. Salinity levels outside the
range of 27-40 ppt also limit reef formation, and low salinity
combined with high turbidity often explain the reef openings
found close to river mouths (Masselink and Hughes 2003).
Corals can survive in high energy wave environments

and even shows enhanced growth on exposed coastlines
(Masselink and Hughes 2003). In the classification system,
the coral category includes both fringing and barrier reefs
fronting rocky coastlines. The separate geological layout
category for coral islands is also assumed to be surrounded
by coral reef environments.

The any category (also indicated with an A in the CHW)

is used when the flora/fauna is not considered to play an
important role for the coastal characteristics and hazard
profile. In some cases, the flora/fauna may have relevant
functions such as the ability of lyme grasses to reduce
aeolian sediment transport, but compared to the other
classification parameters it is not expected to influence the
coastal character significantly.

Data requirements for determining
the flora/fauna

The core data requirements for classifying the flora/
fauna at step 1 are Google Earth’s satellite images,
information on the latitude of the assessment area and
the UNEP-WCMC global coral reef database available at
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Fig. 8. Coral reef
environment in the
Red Sea (Photo:
Oleksandr Chub/
Shutterstock).

http://data.unep-wcmc.org/datasets/1 (UNEP-WCMC 2015).
The Google Earth satellite images are used to visually
evaluate the extension and type of coastal vegetation,

the information on latitude is used to determine whether
coastal wetlands are vegetated with marsh or mangroves
(local photos from Google Earth can also be used for this),
and the coral reef database is used to identify stretches

of coastal coral reefs. It may be difficult to determine the
percentage of vegetation cover for sloping soft rock coasts
based on Google Earth’s satellite images and to avoid
underestimating the hazard levels, it is recommended to
assume that the coastline has no vegetation in cases where
there are doubts about the actual percentage.

For a step 2-3 classification, the data mentioned above
should be supplemented by representative field verification
of vegetation cover, vegetation type and if relevant

coral presence.




2 The CHW and the universal coastal classification system

2.5. SEDIMENT BALANCE

The sediment balance is an essential morphodynamic
parameter and particularly important for coastlines falling into
the sedimentary/soft rock categories. The sediment balance
determines whether there is a net balance, deficit or surplus
of sediment at a particular coastline over time and is largely
determined by the sediment transport/availability and the
relative sea level change.

The sediment transport environment can be divided into

two main types, namely transport of non-cohesive and
cohesive sediment. Transport of non-cohesive, sand-sized
sediment, termed littoral transport, plays an essential role for
the sediment balance of exposed and moderately exposed
sedimentary coastlines. This type of transport is mainly
controlled by the wave height, wave incidence angle and
sediment grain size, and large quantities of sediment

can be transported down the coastline by this process
(Davis and Fitzgerald 2004; Mangor 2004). Coastlines
dominated by littoral sediment transport generally respond
to physical changes by adjusting their theoretical equilibrium
profile, which is the average characteristic form of a coastal
profile, controlled by sediment grain size and to some degree
wave conditions. Changes in sediment availability, storm
conditions or sea level will cause the theoretical equilibrium
profile to shift to a new equilibrium state that matches the
changing framework conditions. Because of this mechanism,
a coastal profile will require more sand to maintain its existing
shoreline position if a new equilibrium profile is created due
to sea level rise. This will lead to shoreline erosion if no net
sediment supply is present.

Transport of fine, cohesive sediment or mud plays an
important role in the sediment balance of protected coastal
areas. Cohesive sediment particles have a relatively low

fall velocity compared to sand grains and the individual
grains have the ability to cohere to each other. These
particles cannot form stable coastal profiles in exposed and
moderately exposed coastlines since they easily go into
suspension. Fine grained, muddy coasts are therefore only
found in protected coastal areas where there is abundance of
cohesive sediment. Such coastlines are generally vegetated
with marsh or mangrove vegetation, sometimes combined
with tidal flats (Mangor 2004). Coastlines dominated by
cohesive sediment can respond to a rising sea level by
growing vertically by increasing the sediment accumulation
rate, but may also suffer from inundation and erosion
depending on sediment availability and tidal dynamics.

In the classification system, the sediment balance section
includes the two main categories balance/deficit and surplus
and the two special categories no beach and beach that
applies to the hard rock coastlines. It has been decided to
group the balance/deficit categories together to simplify

the classification system and to ease the difficult evaluation
of the sediment balance. Coastal areas that are currently
experiencing sediment deficits or only have sufficient
sediment to remain stable at current conditions are likely to
suffer from sediment deficits with a rising sea level unless new
sediment sources emerge (Haslett 2009). Coastal areas that
currently experience sediment surplus might suffer deficits at
a later stage if sea level rises sufficiently or there is a change

in local sediment supply, but these coastlines are less likely to
experience severe sediment deficits in the near future.

For achieving an optimal accuracy of the sediment balance
evaluation, detailed temporal data on coastline stability would
be valuable. As the CHW system is intended to be usable in
areas with limited data availability, however, it is designed to
rely on basic temporal data. Direct short-term observations
are complicated by the fact that single storm and high-wave
events can lead to temporal coastline erosion that is reversed
during calm conditions. The CHW system therefore makes
use of basic historical satellite data available in Google Earth
to evaluate the sediment balance. In case there is any doubt
about the sediment balance evaluation, the user should
assume a balance/deficit as this is the default category for
the CHW system. This is also recommended where there

are any indications of short-term human alteration of the
sediment balance.

For hard rock coastlines, the classification system does not
require a sediment balance evaluation but simply apply a

no beach category if the coast consists of bare rock and a
beach category if some kind of beach environment is present.

Data requirements for determining
the sediment balance

The core data requirements for classifying the sediment
balance at step 1 are Google Earth’s satellite images and
Google Earth’s timeline function. The sediment balance is
evaluated in two different ways depending on whether the
geological layout falls into the sedimentary/soft rock or hard
rock classification categories.

For all sedimentary/soft rock coastlines, it is determined
whether the coastline in question has a sediment balance/
deficit or a sediment surplus using Google Earth’s historical
imagery function.

To facilitate this evaluation, it is recommended to draw a
shore-parallel line in Google Earth at the approximate
vegetation line, based on the most recent satellite image
layer in Google Earth. The sediment balance can then be
estimated by shifting back and forth between current and
historical satellite images, determining whether the vegetation
line has been stable (sediment balance), retreating landwards
(sediment deficit) or advancing seawards (sediment surplus).
In some locations e.g. in desert coastlines, the vegetation

line might not be visible and in that case the approximate
vegetation line or MSL can be used. However, one should

be cautious of using the visible land-water interface from a
few satellite images, as the water level fluctuates between
different images e.g. due to tidal variations and hence does
not provide a real picture of the coastline stability. In case
there are any doubts about the sediment balance evaluation
or possible human alterations such as sand mining or beach
nourishment, the user should assume a balance/deficit as this
is the default category for the CHW system.
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For all hard rock coastlines, the sediment balance is classified
by determining if some kind of beach environment is present
based on Google Earth’s satellite images.

For a classification at step 2, the data should be
supplemented by representative field verification of signs

2.6. STORM CLIMATE

In areas with tropical cyclones, coastal areas can experience
extreme wind, wave, and precipitation conditions that
significantly affect the coastal morphodynamics and hazard
profile. Tropical cyclones are generated over tropical seas
where the water temperature exceeds 27° C. They are
normally generated between 5°-15°N and 5°-15°S and about
60 tropical cyclones are generated annually worldwide with
peak periods in September in the Northern Hemisphere

and in January in the Southern Hemisphere (Mangor 2004).
Wind speeds in tropical cyclones exceed 32 m/s and can
cause extreme wave heights, storm surges and cloudburst.
Although tropical cyclones have a great impact on the coastal
morphology when they hit, the general coastal morphology
of an area is largely determined by the local wave climate
(Mangor 2004).

The classification system distinguishes between locations
with and without tropical cyclone activity, without considering
their frequency. This is decided as tropical cyclones

of longer term erosion/accretion, changes in the vegetation
line and human alterations. For hard rock coastlines,
representative field verification can be used for assessing
presence of beach environments. Step 3 would require
systematic temporal data on shoreline stability.

contribute to the hazard profile in all areas where they occur
regardless of their frequency. The classification system uses
the map shown earlier in Fig 4 to categorize the influence of
tropical cyclones on coastal areas (Masselink and Hughes
2003). In areas indicated to be under “Tropical cyclone
influence” the classification system applies a yes to tropical
cyclone activity while it applies a no for locations outside
these areas. For islands not included in Fig 4, one should rely
on local information on tropical cyclone presence.

Data requirements for determining
the storm climate

The data requirement for evaluating tropical cyclone
presence is the same for all steps 1-3, namely Fig 4.
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Tropical cyclone Katrina
seen from space
(Photo: NASA).




3 The hazard valuation component

THE HAZARD
VALUATION
COMPONENT

of the CHW and are defined as the hazards being an

inherent part of the bio-geophysical properties of a
coastal environment when exposed to the predicted climate
change over the coming decades (IPCC 2013; IPCC 2007a).
The hazards included in the CHW describe the following:

T he hazard values are displayed in the outermost circles

e Ecosystem disruption: The possibility of a disruption of
the current state of the coastal ecosystems under
a changing climate.

e Gradual inundation: The possibility of a gradual
submergence of a coastal environment under a
changing climate.

e Salt water intrusion: The possibility of salty sea water
penetrating into coastal surface waters and groundwater
aquifers under a changing climate.

e Erosion: The possibility of erosion of a coastal
environment under a changing climate.

e Flooding: The possibility of a sudden and abrupt
inundation of a coastal environment caused by a short
term increase in water level due to storm surge and
extreme tides under
a changing climate.

The hazard levels of the CHW are based on a scientific
literature review of the characteristics of the world’s

coastal environments and their susceptibility to
climate-related parameters. As the literature mainly addresses
the susceptibility of different coastal sub-systems, the hazard
graduation is based on a qualitative analysis of how the
various hazards apply to the coastal categories defined in the
CHW classification system.

3.1. ECOSYSTEM DISRUPTION

The graduation of the hazard for ecosystem disruption is
based on the complexity, sensitivity and expected response
to climate change of a particular coastal ecosystem. Where
the flora/fauna category is specified in the classification
system, the ecosystem hazard applies to this particular
biological framework, whereas it applies to the general
biological framework for coastlines where the flora/fauna
category has not been explicitly specified.

The hazard levels should be seen as the hazard presence

in a particular coastal environment in the coming decades.
Since this approach is surrounded by some uncertainty,

the hazard graduation simply distinguishes between four
different hazard levels, depending on the hazard presence.
It is believed that the four-grade system provides sufficient
information to be relevant for decision-support, while at

the same time appropriately reflecting the uncertainties
associated with the hazard graduation methodology. The four
levels included are defined so that 4 equals very high hazard
presence, 3 equals high hazard presence, 2 equals moderate
hazard presence and 1 equals /ow hazard presence.

Each generic coastal environment has been assigned a
specific hazard level for each of the hazard types, and in the
CHW, the graduation is displayed as a combined number/
colour code to give the user the best possible overview of
the hazard profile of a particular coastal environment. A total
of 655 individual hazard evaluations are assigned to the 131
different coastal environments of the CHW 3.0. The specific
conditions for the assigned hazard levels are briefly outlined
in the following sections for the five hazard types coved by
the CHW system.

The hazard of tsunami has not been included as a separate
hazard circle in the CHW as it depends on tectonic activities
up to thousands of kilometres from a particular coastal site
and possible sub-sea landslides, and therefore is very difficult
to determine with certainty. Also, tsunami hazards are not
directly related to climate change. However, due to their
potential devastating effects on coastal areas, tsunami are
addressed together with the other hazard types in this section
and also covered in the sections on hazard management
options and standardized communication codes.

For exposed and moderately exposed sedimentary/littorall
coastal environments, the hazard levels are generally low,

as these environments represent hostile places for biota.

The sedimentary coastlines have a limited flora, and the fauna
are mainly composed of micro- and meiofauna living beneath
the sand surface. The projected increase in sea surface
temperature is unlikely to cause significantly disruption of
these ecosystems as the animals living here are used to
adjust to large temperature fluctuations. The ecosystems
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may, however, to some degree be sensitive to beach erosion
(Brown and MclLachlan 2002).

Protected coastal environments often have greater ecological
diversity than littoral coastlines, when coral coasts are not
considered (Schwartz 2005). This is especially the case for
coastlines with a large tidal range, as these environments
frequently host complex and extensive ecosystems such

as marsh, mangrove and tidal flat environments (Haslett
2009). Marshes are generally characterized by high primary
production and high species diversity and provides nursing
grounds for a range of different marine animals including fish
species (Simas et al. 2001). Together with adjacent tidal flat
environments, these areas also constitute important habitats
for bird populations (Hails 1997). Their response to climate
change highly depends on their ability to keep up with sea
level rise and hence the sediment availability (IPCC 2014;
IPCC 2007b). Mangrove environments are highly complex
ecosystems with a high primary productivity. They are among
the most productive ecosystems on earth and material
export from mangrove forests provide organic matter that
acts as an food and energy source for marine primary

and secondary production (McMullen and Jabbour 2009;
Jennerjahn and Ittekkot 2002). Climate change combined
with stressors from human activities such as clearing of
mangroves for aquaculture pose a risk to the diversity of
coastal mangroves (IPCC 2014; IPCC 2007b). Yet, mangroves
have demonstrated a high resilience to change over historic
time scales (Gilman et al. 2008). Climate change is projected
to cause a maximum loss of global mangrove forests of
10-15 percent which is secondary to current rates of human
deforestation (Alongi 2008). Mangroves occupying low relief
islands or carbonate beaches with limited sediment supply
are generally considered especially vulnerable (Alongi 2008).
Protected coastal environments with a low tidal range can
have an increased risk of wetland loss (Nicholls 2004).

Coral reef environments are among the most biologically
diverse ecosystems on the planet (Hoegh-Guldberg et al.
2007). They are expected to be highly sensitive to climate
change and especially at risk from increasing ocean
temperature and ocean acidification (McMullen and Jabbour
2009). Mass coral bleaching is clearly correlated with rises
of sea surface temperature of short duration above summer
maxima (Lesser 2004; McWillams et al. 2005) although it

is unclear whether bleaching takes place as an adaptive
symbiotic strategy or as a symptom of damage caused

by changing environmental conditions (Douglas 2003).

It is considered very likely that a projected sea surface
temperature increase of 1-3 °C will result in more frequent
bleaching events and coral mortality if significant thermal
adaptation is not taking place (IPCC 2007b; Sheppard 2003).
With the currently predicted temperature increase, bleaching
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could eliminate shallow-water corals within a few decades
(Hallock 2005). The increased acidification of sea water and
the decreasing carbonate-ion concentration will reduce the
calcification rates of marine organisms including reef-building
corals (Hoegh-Guldberg et al. 2007; Guinotte et al. 2003).
Experimental studies have shown that a doubling of pre-
industrial atmospheric CO, concentrations decreases coral
calcification rates and growth by up to 40 percent (Hoegh-
Guldberg et al. 2007). The projected reduction in oceanic pH
can be as much as 0.4 pH units by the end of this century
and ocean carbonate levels may drop below the level for
sustaining coral reef accretion by 2050 (Hoegh-Guldberg

et al. 2007). Coral reefs are expected to be able to keep

up with sea level rise over the next decades, but this may

be of minor importance as they are likely to suffer from the
changes in water temperature and acidification (IPCC 2014;
IPCC 2007b). Furthermore, intensification of tropical cyclones
could have very damaging effects on coral reefs (IPCC
2007b). Together with the sensitive coral reef ecosystems
associated with coral islands, freshwater dependant
ecosystems on these sites also harbour rare and endemic
species. These ecosystems are highly sensitive to sea level
rise and the associated risk of salt water intrusion (McMullen
and Jabbour 2009).

Table 3 provides an overview of the key coastal
characteristics influencing the allocation of hazard levels for
ecosystem disruption. The specific allocation of hazard levels
is carried out by expert judgement for each of the 131 coastal
environments of the CHW.

Key coastal characteristics

Corals
Marsh vegetation

. Mangrove vegetation
Contribute

to high
hazard levels

Sediment balance/deficit
Low-moderate wave exposure
Slope vegetation

Tidal inlet/sand spit/river mouth

Sediment surplus

Contribute to low

hazard levels No designated flora/fauna systems

High wave exposure

Table 3. Key coastal characteristics determining the hazard
levels for ecosystem disruption.




3 The hazard valuation component

3.2. GRADUAL INUNDATION

The hazard for gradual inundation reflects the possibility of
a gradual submergence of a coastal environment under a
changing climate. Contrary to flooding, gradual inundation
takes place over years to decades when the sediment
deposition and growth of biological organisms cannot follow
suit with the rising sea level.

Coastlines with a flat geological layout such as sedimentary
plains, barriers, delta/low estuary islands, flat hard rock
coasts and coral islands generally have a higher hazard
level. Delta environments are considered particularly
sensitive to sea level rise (Ericson et al. 2006; Woodroffe et
al. 2006) and current rates of sea level rise in deltas tend to
be greater than the global average due to delta subsidence
(IPCC 2014; IPCC 2007b). Gradual inundation of delta
environments largely depends on the fluvial sediment supply
and most deltas no longer maintain their natural sediment
supply due to upstream damming activities and are thus
experiencing sediment deficits as they are subsiding due

to the weight of the accumulated sediment (IPCC 2007b;
Masselink and Hughes 2003). Other human activities such
as withdrawal of oil, gas and groundwater contribute further
to delta subsidence (Ericson et al. 2006) and many delta
environments are already changing rapidly, even before
human induced sea level rise has started to accelerate (IPCC
2014; IPCC 2007b).

Exposed and moderately exposed littoral coastlines are
generally expected to respond to sea level rise through
adjustments in their theoretical equilibrium profile with
associated coastal erosion if no additional sediment is
supplied to the coast (Masselink and Hughes 2003). Gradual
inundation will therefore often be a secondary effect of sea
level rise for these coastlines. Protected coastlines, on the
other hand, will be particularly susceptible to gradual
inundation and for these coastlines, the sediment balance

is essential for their ability to follow sea level rise through
vertical sediment accretion (Haslett 2009; Richards et al.
2008). If enough sediment is available, marsh, mangrove and
tidal flat areas may be able to follow a rising sea level through
vertical accretion, while they are likely to drown in locations
with a low sediment supply. Along with sediment availability,
tidal range may also influence inundation hazards, as marsh
environments with a high tidal range are considered to be
less vulnerable to sea level rise (Simas et al. 2001).

Although marsh and tidal flat areas may be able to follow
arising sea level in areas with sufficient sediment supply,
they are still at risk if sea level rises too rapidly. Studies
conclude that a widespread submergence of the Wadden
Sea is projected if the sea level rise exceeds 10 mm/yr (Van
Goor et al. 2003). If a marsh area cannot keep pace with

a rising sea level, it will begin to migrate inland if enough
accommodation space is available. If human activities

are limiting this migration, the total marsh area is likely to
decrease due to coastal squeeze (Haslett 2009).

For mangrove environments, sea level rise is considered

the greatest climatic threat and currently most mangrove
sediment surfaces are not keeping pace with sea level

rise (Gilman et al. 2008). Some studies indicate, however,
that mangroves may be able to tolerate significant sea level
rise (Morris et al. 2002). The stability of mangrove forests is
likely to depend on the sediment availability along with the
ability of mangroves to produce sufficient organic material to
maintain their peat foundation during a rising sea level (Simas
et al. 2001). As with marsh environments, coastal squeeze
may limit the landward migration of mangrove forests,
decreasing their total areal extension (Haslett 2009).

Coral reef environments may be at risk from gradual drowning
if they fail to keep up with the rising sea level. Calculations

of coral reef growth and geological core studies estimate

the upward growth of coral reefs to 1-10 mm/year (Masselink
and Hughes 2003) and it is expected that a sea levels rise
greater than 20 mm/year would lead to coral drowning
(Spencer 1994). Although gradual inundation of corals may
become an issue with a rapid sea level rise, it is considered
a smaller component compared to the expected increase in
sea surface temperature and ocean acidification (IPCC 2014,
Hoegh-Guldberg et al. 2007).

Table 4 provides an overview of the key coastal
characteristics influencing the allocation of hazard levels for
gradual inundation. The specific allocation of hazard levels is
carried out by expert judgement for each of the 131 coastal
environments of the CHW.

Key coastal characteristics

Coral island
Delta/low estuary island

Contribute Other low-lying geological layout
to high

hazard levels

Sediment balance/deficit
Low-moderate wave exposure

Beach environment at hard
rock coasts
Contribute to low Sediment surplus

hazard levels Sloping geological layout

Table 4. Key coastal characteristics determining the hazard
levels for gradual inundation.
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3.3. SALT WATER INTRUSION

The graduation of the hazard for salt water intrusion reflects
the possibility of salty sea water penetrating into coastal
surface waters and groundwater aquifers under a changing
climate. Many coastal groundwater aquifers are already
experiencing salt water intrusion and it is expected that this
phenomenon will be exacerbated by future sea level rise
(Essink 2001). Shallow water aquifers are particularly at

risk and in many places they already suffer from extensive
salt water problems due to both natural and anthropogenic
causes (Essink 2001). The intrusion of salt water can pose
a great threat to future public water supply, agriculture and
horticulture (Essink 2001) as well as pose a threat to existing
natural ecosystems (Burkett and Kusler 2000).

The hazard of salt water intrusion is controlled by a
combination of coastal geology, aquifer dimensions, human
groundwater withdrawal, surface water recharge, submarine
groundwater discharge and local precipitation (IPCC 2007b).
Coastal areas with a flat geological layout are generally more
susceptible for salinization of shallow aquifers as gradual
inundation, erosion and higher flooding levels increases the
landward reach of salty sea water (IPCC 2014; IPCC 2007b).
Shoreline retreat can affect coastal aquifers by reducing

the width and area of sand dunes, thereby diminishing the
length over which groundwater recharge occurs (Essink
2001). Deltas/low estuary islands will experience increased
salt water intrusion from sea level rise if these environments
cannot keep pace with the rising sea level, and in locations
with low sediment availability nearby aquifers can be
especially threatened (Essink 2001).

Salt water encroachment from sea level rise may eliminate
some species living in brackish coastal wetland habitats and
climate change is likely to have an impact on brackish and
freshwater marshes due to changes in hydrological regimes
(Sun et al. 2002; Burkett and Kusler 2000). In areas with
decreasing rainfall and increasing evaporation, mangroves
can experience decreased productivity and decreased
seedling survival due to conversion of upper tidal zones to

3.4. EROSION

The graduation of the hazard for erosion reflects the
possibility of coastline erosion and is controlled by a range
of classification parameters. The geological layout expresses
the potential erodibility of the coastline and thus determining
if any significant erosion can happen in the first place (Davis
and Fitzgerald 2004). Geological layouts of sedimentary/soft
rock origin have a relative high erodibility, while hard rock
coastlines show little erosion over timescales used in coastal
management (IPCC 2007b). Where beach environments are
present along hard rock coastlines, erosion of the beach
environment may occur while the rocky coastline itself is likely
to remain stable (Masselink and Hughes 2003). The slope

of the geological layout also influences the erosion rates

as coastlines with a flat layout generally retreat faster than
steeper coastlines (Thieler et al. 2000). Barrier coastlines
may due to a rising sea level migrate landwards through
erosion, overwash and loss of sediment and in some cases
barrier overstretching can lead to barrier breaching and
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hypersaline flats (Gilman et al. 2008). Many small islands are
likely to experience increased water stress and depletion of
freshwater lenses due to changing precipitation patterns and
rising sea level (IPCC 2014; IPCC 2007b).

Nevertheless, the risk of salt water intrusion is largely related
to human water extraction and the presence of this hazard
therefore arises from a combination of natural and human
conditions (IPCC 2014; Essink 2001). In the CHW system,
however, the focus is solely on the natural hazards.

Table 5 provides an overview of the key coastal
characteristics influencing the allocation of hazard levels for
salt water intrusion. The specific allocation of hazard levels is
carried out by expert judgement for each of the 131 coastal
environments of the CHW.

Key coastal characteristics

Coral island

Delta/low estuary island

Contribute Barrier
to high

hazard levels Other low-lying geological layout

Tropical cyclone activity
Sediment balance/deficit

No tropical cyclone activity

Contribute to low

hazard levels Sloping geological layout

Sediment surplus

Table 5. Key coastal characteristics determining the hazard
levels for salt water intrusion.

disintegration (Haslett 2009). Sloping soft rock coasts are
also likely to retreat more rapidly in the future due to an
increased erosion of a possible cliff profile. Soft rock cliff
erosion often takes place in episodic intervals and the rate
of erosion is controlled by a range of parameters including
wave exposure, sediment balance, precipitation intensity
and groundwater levels (IPCC 2014; IPCC 2007b). Infilling of
estuaries and lagoons with sediment during a rising sea level
can lead to major sediment deficits and erosion at coastlines
in the vicinity of tidal inlets (Van Goor et al. 2003).

In exposed and moderately exposed littoral environments,
the wave exposure is a key parameter for sediment transport,
and in areas with negative sediment balance, high wave
exposure can lead to significant coastal erosion due to loss
of large quantities of sediment by offshore and longshore
transport (Mangor 2004). In areas with current sediment
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surplus, high wave exposure will not necessarily lead to
erosion, unless future sea level rise happens faster than
additional sediment is supplied to compensate the changing
theoretical equilibrium profile. Moreover, at any coastline with
littoral sediment transport, there is a risk that local changes
in wave and currents due to climate change could modify
the rate and direction of the littoral transport (Masselink and
Hughes 2003). Increased frequency and intensity of storms
are likely to lead to escalated beach erosion (Brown and
Mclachlan 2002) and changes in sediment sources such as
fluvial sediment supply can shift a sediment surplus into a
deficit. Generally, the Bruun rule can be used to estimate the
effects of sea level rise on littoral coastlines and a horizontal
shoreline retreat is estimated to be 50-200 times the rise in
relative sea level (IPCC 2007b).

In protected coastal environments, the tidal range is an
important parameter for the sedimentation processes.

In environments with a high tidal range, a sediment surplus
can lead to a gradual sediment accumulation on the tidal
flats that keep pace with the sea level rise. A sediment
deficit, on the other hand, will lead to gradual inundation and
various degrees of erosion (Masselink and Hughes 2003).
The flora/fauna is important in protected coastal areas as
marsh and mangrove vegetation can trap sediment and keep
it deposited during extreme storm events. If marsh areas are
gradually inundating due to a rising sea level, they may suffer
from erosion as increased water depths enable increased
wave action on the marsh edges (Masselink and Hughes
2003; Simas et al. 2001). The seaward margins of mangrove
forests can also erode as a consequence of a rising sea

level (Alongi 2008; Gilman et al. 2008). Vegetation of sloping
soft rock coasts has an important effect in reducing erosion
and gully formation from heavy precipitation events and
groundwater seeping.

Degradation of coral reef systems may result in more wave
energy across the reef flat reaching the shore, increasing
the potential for erosion (IPCC 2007b; Sheppard et al.

2005). The reduced calcification rates in the oceans due to
climate change may lead to a reduction of coral skeleton
density. This could increase the vulnerability of coral reefs

to wave exposure and tropical storms, leading to increased
coastal erosion (Hoegh-Guldberg et al. 2007). The rising sea

3.5. FLOODING

The graduation of the hazard for flooding is related to the
possibility of a sudden, abrupt and often dramatic inundation
of a coastal environment caused by a short term increase in
water level due to storm surge, extreme tides and seasonal
variations (Mangor 2004). A gradual relative sea level rise will
also lead to higher extreme water levels.

The flooding hazard is closely related to the geological layout,
with sedimentary plains, barriers, delta/low estuary islands,
flat hard rock coasts and coral islands being particularly
vulnerable (IPCC 2014; IPCC 2007b). In delta environments,
a rising sea level combined with a storm surge, heavy
precipitation and associated peak river flow can lead to
extensive flooding. This is further exacerbated in areas with
tropical cyclone activity, and increased cyclone intensity due

level combined with increased tropical storm intensity also
mean that coral islands are likely to experience significant
erosion and a possible reduction of island size (IPCC 2014;
IPCC 2007b).

Table 6 provides an overview of the key coastal
characteristics influencing the allocation of hazard levels for
erosion. The specific allocation of hazard levels is carried out
by expert judgement for each of the 131 coastal environments
of the CHW.

Key coastal characteristics

Sediment balance/deficit

Tidal inlet/sand spit/river mouth
Coral island

Delta/low estuary island

Contribute Other low-lying sedimentary layout

to high

Sloping soft rock
hazard levels

High wave exposure
Tropical cyclone activity
No vegetation on coastal slopes

Beach environment at hard
rock coasts

Hard rock layout

Sediment surplus
Contribute to low No tropical cyclone activity
hazard levels .

Vegetation on coastal slopes

No beach environment at hard
rock coasts

Table 6. Key coastal characteristics determining the hazard
levels for erosion.

to climate change can also increase flooding hazards
(IPCC 2014; IPCC 2007b).

Tidal range influences the flooding hazard of coastal
environments by affecting the daily and maximum water
levels. Different arguments have been put forward about the
relationship between tidal range and flooding hazards, but it
is generally accepted that the flooding risk increases with
decreasing tidal range (Thieler et al. 2000). This is the case
as there is only a certain, relatively low, probability that a
storm will occur at the same time as a high tide. In micro-tidal
environments, the water level is always near its maximum
level and therefore has little space for further increase before
passing the normal high tide level. In meso/macro-tidal
environments, water levels can most of the time increase
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significantly during storm events before reaching the high tide
level (Thieler et al. 2000).

Marsh and mangrove environments are often flooded as part
of their natural dynamics. It is well established that mangrove
forests protects the coastline from tropical cyclone and
flooding events, and degradation of these systems due to
human activities may increase the extension and damage
from flooding due to climate change (IPCC 2014).

Table 7 provides an overview of the key coastal
characteristics influencing the allocation of hazard levels for
flooding. The specific allocation of hazard levels is carried out
by expert judgement for each of the 131 coastal environments
of the CHW.

3.6. TSUNAMI

Tsunami are produced by a number of different mechanisms
including displacement of the seafloor by submarine
earthquakes, large ocean landslides, volcanic eruptions,
calving glaciers and an asteroid impact (Haslett 2009;
Schwartz 2005; Masselink and Hughes 2003). In the open
ocean, tsunami waves can have wavelengths of hundreds of
kilometres and wave heights of less than a few meters and
can travel across ocean basins at a speed of around 800
Km/h, hardly being noticed by ships (Masselink and Hughes
2003). With that speed they can rapidly cross large ocean
basins such as the Pacific.

When tsunami cross the edge of the continental shelf,

they rapidly begin to shoal, meaning that they slow down,
become shorter in wavelength and larger in wave height.

By the time they reach the coastline they can be over ten
meters high, have run-up heights of tens of meters and can
cause enormous damage as witnessed with the Indian Ocean
tsunami in 2004 and the Great East Japan tsunami in 2011
(UNEP 2015; Haslett 2009; Masselink and Hughes 2003).

A tsunami-generating event will usually create a series of
tsunami waves that may repetitively affect a coastline for up to
24 hours (Haslett 2009). The highest tsunami may even occur
hours after several lower ones have passed (Schwartz 2005).
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Key coastal characteristics

Delta/low estuary island

Coral island

Barrier
Contribute Sedimentary plain
to high

hazard levels Flat hard rock coast
Tropical cyclone activity
Low tidal range
Sediment balance/deficit
Sloping geological layout

Contribute to low O tropical cyclone activity
hazard levels Sediment surplus

High tidal range

Table 7. Key coastal characteristics determining the hazard
levels for flooding.

It can be difficult to project the occurrence of tsunami and
many world regions normally not associated with tsunami
events have geological record of tsunami occurrence.

For example, there is geological evidence that the UK coast
has been affected by a tsunami and this is also the case
for the coast of Norway, Portugal and Italy (Haslett 2009;
Schwartz 2005). The Atlantic Coast of North America is also
considered potentially at risk from a destructive tsunami
because of slope instabilities on the continental shelf
(Schwartz 2005). However, the Pacific Ocean remains the
region where 90 percent of all destructive tsunami occur,
with an average occurrence of two per year (Haslett 2009;
Schwartz 2005).

In the CHW system, coastal environments that have a
geological layout of the type sedimentary plain, barrier, delta/
low estuary island, flat hard rock, coral island and tidal inlet/
sand spit/river mouth could have a significant inherent hazard
for tsunami impacts if they border waterbodies with possible
tsunami occurrence. Coasts with geological layouts of the
type sloping soft rock and sloping hard rock with beach
environment that are used for e.g. recreational activities could
also have an inherent hazard for tsunami impacts on human
activities. Coastal planners should therefore take possible
tsunami hazards into account in the planning process and
acquaint themselves with tsunami management activities in
their region.




4 Application for local, regional and national multi-hazard-assessments

APPLICATION FOR
LOCAL, REGIONAL
AND NATIONAL
MULTI-HAZARD-
ASSESSMENTS

multi-hazard-assessments and for spot-assessments

to identify the hazard profile and possible management
options for a particular coastal site. Depending on the
data availability and accuracy requirements, coastal multi-
hazard-assessments can be implemented at any of the
three classification/assessment steps mentioned earlier.
It should be noted, however, that the coastal classification
always applies to coastal sections of 200-300 meters
regardless of assessment step; the steps only describe the
data requirements and general accuracy, with the following
guiding principles:

T he CHW can be applied for local, regional and national

e Step 1is designed for hazard assessments where data
availability and accuracy requirements are relatively low.
This step can generally be implemented based on remote
sensing and publicly available data and is useful for
hazard screening and for getting an initial picture of the
hazard presence in a cost-efficient manner.

e Step 2 is designed for hazard assessments with moderate
accuracy and this step generally requires additional field
verification of the data obtained though remote sensing
and public data sources.

e Step 3 is designed for hazard assessments with a
relatively high accuracy and this step requires field
verification combined with high quality datasets for key
classification parameters.

Generally, step 1 and 2 are recommended for larger
sub-regional, regional and national screenings, while step

3 can be used for coastlines where more comprehensive
information is needed. Spot-assessments for a specific
coastal site can be carried out at any step depending on
accuracy requirements, but it is important to be aware of the
associated uncertainties if the assessment is carried out at
step 1-2.

4.1. MANUAL ASSESSMENT PROCEDURE

For use for local/spot-assessments, it may be appropriate
simply to note down the results from the CHW, i.e. the coastal
classification code and hazard values. For regional and
national assessments, a manual assessment procedure for
ArcGIS is outlined below which allows for development of

high-quality hazard maps and hazard layers for Google Earth.

Further information on ongoing data activities can be found
at www.coastalhazardwheel.org.

The manual assessment procedure can be carried out when
the preparatory data collection and analysis mentioned in
chapter 2 has been completed. This includes having created
the necessary supporting line features in Google Earth for
properly evaluating the coastal slope and sediment balance.

The assessment is carried out using the CHW and is done
through a range of continuous assessments along the
coastline with an approximate distance between each
assessment of 200-300 meters. Sometimes a coastline
can maintain the same properties for many kilometres,
while at others, it changes for every few hundred meters.
If the same coastal type extends for longer distances,

a single classification segment can extend for more than
200-300 meters when classified in ArcGIS to ease the
practical classification procedure.

This section describes the procedure for carrying out the
coastal classification and multi-hazard-assessment in
ArcGIS, using Esri's ArcGIS Desktop ver. 10.3 (at all license
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levels). First, it is explained how to digitize a coastline if not
already available. Next, how to split up the coastline into
segments in accordance with the CHW system. Finally, it is
described how to visualize the data and present a summary
of the classification. All data are saved in an ArcGIS file
geodatabase that automatically updates the lengths of
segmented features. The segmentation will be based on
images available online from Esri’s Online services. Therefore,
it is assumed that the PC used is connected to the internet.

The procedure for carrying out the coastal classification
and multi-hazard-assessment in ArcGIS contains the
following components:

e Prepare a folder, a file geodatabase and feature classes
¢ Digitize the coastline

e Split the coastline into segments and assign CHW values
e Symbolize categories

e Save categories as layer files

e Summarize segment lengths by categories

e Create layouts from the layers
e Export layers to a PDF file

e Conversion of layers in ArcMap to Google KMLs

Prepare a folder, a file geodatabase and
feature classes

To prepare the storage of the coastline, a folder and a file
geodatabase with an empty line feature class must be
established first with a suitable projected spatial reference.

1) Create a new folder on your hard drive to store
your data.

2) Open ArcGIS Desktop. Open ArcGIS Desktop with a
blank map document and from the main menu select
Windows -> Catalog. When opened ArcMap may look as
shown in Fig 9 and the Catalog can be locked in place by
clicking the pin in the upper right corner.
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main window.

3) Establish a new folder. In the Catalog window click the
Folder Connection icon £, navigate to the new folder you
created in step 1 and click OK. A file connection is now
established to your folder and will appear as an entry in
your Catalog.

4) Create a new file geodatabase. In the Catalog
window right click your new folder, select New -> File
Geodatabase, enter a suitable name for it (without
spaces and special characters) and press Enter.

5) Create a new empty Coastline feature class.

a) Expand your folder in the Catalog window, right click
the name of your new file geodatabase and select
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New -> Feature Class. Enter a name for it, for example
Coastline, make sure that the “Type of features ...” is set
to Line Features and press Next.

b) Choose a projected coordinate system for your
digitized coastline (preferably use the UTM projection
that covers your area) by entering the Projected
Coordinate Systems section -> UTM -> <region> ->
<Specific projection>. For example for the eastern part
of Denmark select Projected Coordinate Systems ->
Europe -> ETRS 1989 Zone 32N and press Next.

c) Accept the next default value for the XY tolerance and
Database Storage Configuration by pressing Next 3
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times and click Finish to close the setup. Now, a new
empty feature class should be visible in your file
geodatabase, see Fig 10, and also loaded automatically
to your Table of Contents. Being loaded onto ArcMap
the feature class is now represented by a Layer
(although empty at this moment) in the Layers section
located in the leftmost pane of ArcMap.

= ] CATempiLRS
] Thomas.gdb

; ; Fig. 10. Feature
) Coastline

class view.

6) Enable a default file geodatabase. In order for ArcGIS
to remember the path to your file geodatabase please
right click the new file geodatabase and select Make
Default Geodatabase.

Digitize the coastline

Now, a coastline can be digitized from an image already
available from ArcGIS Online as so called basemaps.

By default most online basemaps are saved in a Web
Mercator map projection which is not appropriate for our
purposes because it's not true to distances. However, if your
new empty Coastline feature class is loaded into ArcMap
first, and the basemap is added next, the basemap will

be converted on-the-fly to the Coastline’s map projection.

As your empty Coastline feature class is already loaded as a
layer, everything is okay.

7) Add basemap. Click the tiny arrow to the right of the Add
Data icon *- in the main menu, select Add Basemap ->
Imagery and click Add. Be patient and await the display
of the image that will be transformed on-the-fly to match
the spatial reference of your Coastline layer (the drawing
may take a while depending on the speed of your internet
connection. While loading the basemap you will notice a
globe spinning below the Catalog window). Please notice
that it can be important to have a fast internet connection
in order to ensure a fast reload of the basemap.

8) Zoom in. Use the Zoom [% and Pan ' tools to focus on
your area of interest and where you want to start digitizing
in a moment. If your mouse has a scroll wheel you can
turn it to zoom in or out of your map — just be patient until
the display is refreshed.

9) Add the Editor toolbar. From the main menu select
Customize -> Toolbars -> Editor and move the new
toolbar, see Fig 11, to a suitable location. All the icons
are dimmed out because an edit session hasn'’t been
started, yet.

Editor~
Fig. 11. The Editor toolbar.

10) Start digitizing. From the Editor toolbar dropdown
ester- click Start Editing and notice that some of the

icons are ready for activation. Click Create Features *

. A new window pops up to the right of your Catalog
window. In there click the name of the layer: Coastline,
move your cursor to the imagery (notice that a crosshair
is appearing) and click the starting point to digitize,

the next point to mark the coastline and so forth. You may
zoom in and out by scrolling your mouse wheel but if you
need to pan you must click the « first, and when done
go back to the Create Features pane and click on the
Coastline name to continue digitizing. Keep on clicking
your mouse to digitize points along the coastline with
varying densities (few points along straight coastlines
and several where it bends). Double-click to finish

your digitizing. If you want to add more points re-click
the name of the feature class, Coastling, in the Create
Features pane, move your cursor to the imagery and
you'll see that if you move your cursor to a position

close to the endpoint where you stopped your previous
digitizing, it will automatically snap to it, see Fig 12.

Fig. 12. Digitization
of coastline.

11) Stop digitizing. In the Editor dropdown select Stop
Editing and answer Yes to save your edits.

12) Create a backup copy. Create a backup copy of your
digitized coastline by right-clicking the feature class’
name in the Catalog window, choose Copy, right-click on
the name of your file geodatabase and select Paste. In a
popup window press OK to confirm the copy process.
Finally, right-click the copy by default named Coastline_1,
select Rename, type the name Coastline_original and
press Enter.

Split the coastline into segments and assign
CHW values

Having digitized the coastline you're ready to split it into
segments and assign CHW classification codes to it.

13) Open the Coastline’s attribute table. Right click the
Coastline layer name in the Table of Contents pane
and select Open Attribute Table. The attribute table is
then shown as in Fig 13. Keep the Attribute Table open
but maybe move it a little aside from your Data Frame.
For example put it into the bottom of your Table of
Contents pane.

Table ox
B B R
Ceastline x

OBJECTID * SHAPE* | SHAPE_Length
Polyline 57 53178
2 | Polyline 32 05

3

o4 1 v n |[E|= (0outof 2 Selected)

Fig. 13. Attribute table for
the Coastline.

Coastline
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14)

Table

Add a new field to the attribute table. In the attribute
table window click the tiny arrow to the right of the upper
left symbol for Table Options, see Fig 13 and select

Add Field to insert a new attribute field into the table.
For Name type CHW, set the type to Text and press OK.
Notice that a new field with an empty value (<Null>) is
inserted as shown in Fig 14. Keep the attribute table’s
view open, still.

R -1 ]

Coastline X

| OBJECTID® | SHAPE* | SHAPE_Length CHI

1 | Polyline 7 053178 | <Null=

B 2 | Polyline 05 | <Hull=

o 0 » n [EE ©outof 2 Selected) Fig. 14. New CHW field in
[Coting the attribute table.
15) Begin segmentation. From the Editor toolbar dropdown

16)

a)
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click Start Editing. By default the Edit tool * is activated,
so double-click somewhere on the coastline and you

will see several green squares being drawn along it

and the coastline itself highlighted in a turquoise colour,
see Fig 15. The squares symbolize vertexes that are start
and ending points for the line segments that you just
digitized. However, all the segments are part of one big
selected line feature (indicated by the turquoise colour).
What you're going to do now is splitting up this line
feature into individual features that you assign different
CHW codes to.

Fig. 15. Coastline with
start and end-points for
digitized line segments.

Create segments.

Having your basemap imagery open as a background
map go to the Editor toolbar and click the Split Tool

. Zoom into your coastline close to the start or the
ending point of it and decide where you want to split
it to identify your first segment. Remember that if your
mouse has a scroll wheel, you can turn it to zoom in
or out of your map — just be patient until the display is
refreshed. At a proper split location click your mouse
and notice that all markers and selections disappear.

The Edit Tool * is automatically re-activated so click
on that part of your splitted coastline onto which you
want to assign a CHW code. Notice that the line feature
is highlighted which means that it's selected. In your
attribute table the entire record representing your
selected line feature is highlighted, too. So, click on the

-~

highlighted cell in the CHW column having a Null value,
type your CHW code for the line feature (example:
BA-18) and press Enter. Now this piece of the coastline
has been coded.

In the Editor toolbar re-click the Edit Tool icon * . Single
or double click the next piece of coastline that you
want to split up (if you double click you will notice all
the vertexes digitized on the selected feature — if you
single click the vertexes are not displayed). Activate
the Split tool ~ on the Editor toolbar, move your cursor
to the position where you want to split the coastline and
click your mouse. Go to the attribute table and enter
the CHW code for the selected line feature like in the
previous step.

Repeat steps a-c all along the coastline until all

of it is segmented and coded with CHW codes.
When appropriate during this process click the Editor
toolbar dropdown and select Save Edits.

17) Check segments. Before stopping your edit session

Takle

you must make sure that the entire coastline has been
split at the right locations. If you need to subsplit a line
feature already coded just select it using the Edit Tool *
activate the Split tool ~ and click at the location to split it.
Now, as you've split a line that already had a CHW code,
you must use the Edit Tool * to select the proper line
feature and change its CHW code in the attribute table.

Also, scroll through your attribute table and if you identify
a line feature with a CHW code = Null, you can zoom to

it quickly by right clicking its record’s leftmost cell in the
attribute table, see Fig 16, and select Zoom to Selected.
Then you can inspect that piece of coastline and go back
to your attribute table and enter the right CHW code.

Fig. 16. Attribute table
with a line feature without
CHW code.

Symbolize categories

18) Display the CHW codes as labels. One way to display

19

=

all your CHW codes along the coastline is to activate
labelling of your feature layer. First, unselect all selected
features by clicking the Clear Selected Features tool =

. Also, zoom to the extent of your Coastline layer by right
clicking its name in the Table of Contents pane and select
Zoom to Layer. Next, right click your Coastline layer’s
name in the Table of Contents, select the bottom option:
“Properties”, enter the “Labels” tab, check the upper left
option: “Label features in this layer”, go to “Label Field”,
from the pull down list select CHW and press Apply.

Display CHW codes with different symbologies.
To symbolize your different CHW types along the
coastline change the tab to “Symbology”, select
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Categories -> Unique Values, change the value Field to
CHW and click “Add All Values”. Now, the line width may
be a little small, so click the word “Symbol”, see Fig 17,
select “Properties for All Symbols”, increase the Line
Width to 2, press OK to return to the Symbology window
and press OK there, too. Now, your labels should appear
together with a colouring of your coastline features,

see Fig 18. Before you proceed you can turn off your
labels again by right-clicking your Coastline layer’s
name in the Table of Contents, select the bottom option:
“Properties”, enter the “Labels” tab, and uncheck the
upper left option: “Label features in this layer” and

press OK.

20) Stop editing. When you’re done reviewing your edits
click the Editor Tool, select Stop Editing and confirm that
you want to save your edits.

21) Join information about hazards to the CHW codes.
The CHW codes represent 5 hazard values: Ecosystem
disruption, gradual inundation, salt water intrusion,
erosion and flooding. To add these values to the
classified coastal segments, you can join a table with
these values onto your coastal segments. The table
describing the hazard values for every single CHW code
is saved in a table named Hazard_values (available
from www.coastalhazardwheel.org), see Fig 19. First,
save it to the folder on your desk where you have your
geodatabase and add this table to ArcMap by right-
clicking on the Geodatabase, choosing Import table
(multiple) and import it from where it is saved, and then
drag its name from the Catalog Window and onto the
Table of Contents, see Fig 20.
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Now, this table can be joined onto the digitized coastline
by right-clicking the Coastline layer’'s name, select Join
and Relates -> Join. In the Join Data popup window select
that you want to ‘Join attributes from a table’, click the tiny

Fig. 17. Changing
the symbology for
the coastline.

Fig. 18. Coastline
with CHW labels and
colour coding.

2y

et

Fig. 19. The
Hazard_values table.

Fig. 20. Dragging the
Hazard_values table to
the Table of Contents.

arrows to the right in the selectable fields that the join (1) will
be based on to CHW, set the table to join (2) to this layer to
Hazard_values, Choose the field in the table (3) to base this
join on to CHW. Use the default for the rest of the settings and
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press OK. Now, right-click the Coastline layer’'s name in the
Table of Contents pane, open its attribute table and notice
how nicely the hazard value have been added to your CHW
values, see Fig 21.

Sat water | Ercalom | Fiooding | -

"o 1or w8 ] 0 out of 17 Selecte)

Coastline

Fig. 21. The joined attribute table.

Save categories as layer files

22) Save the hazard classifications as 5 individual layer
files. Like you displayed the CHW codes in step 18,
you are now able to display the 5 individual hazard codes
for the coastline and save them in 5 different layer files.
In order to assign the same hazard level colours to all 5
themes you will re-use an already saved layer template.

a) First, you must save your joined output to a new feature
class by right-clicking the Coastline layer's name,
select Data -> Export Data, make sure that the output
location is your file geodatabase, assign the name:
CoastlineWithHazards to your output and press Save.
When asked: ‘Do you want to add the exported data to
the map as a layer?’ click Yes. When the layer appears
your CHW symbologies are gone as they haven't been
specified for this layer, but never mind that.

b) Double click the CoastlineWithHazards layer's name
(this shortcut takes you directly into the layer’s
properties) and click on the Symbology tab.

c) Click the Import button -> Select ‘Import Symbology
definition from another layer ...”, click the yellow
Folder button, navigate to your folder in which you
have saved your geodatabase, click the Layer
Template.lyr (can be downloaded to the folder from
www.coastalhazardwheel.org), press Add.

d) Inthe new popup window’s Value Field select
Ecosystem_disruption, press OK to return to the Layer
Properties window.

e) Inthe Layer Properties Window click the General tab,
change the Layer Name to Ecosystem Disruption
and click OK to close the Layer Properties. Now,
the Ecosystem Disruption hazard values are displayed
and can be saved as a layer file in a folder that you can
reload whenever convenient.

f)  To save it right click your renamed layer, select Save
As Layer File, navigate to your folder in which you
have your file geodatabase (but don't enter the file
geodatabase), and enter Ecosystem Disruption as
the layer's name and press save (the .lyr extension is
automatically added to the file name).

MANAGING CLIMATE CHANGE HAZARDS IN COASTAL AREAS - MAIN MANUAL 26

g) Finally, from now on when you open ArcMap you may
just load that layer file into ArcMap from your Catalog
window to restore your symbology.

Now, redo step 22 b through f and produce layer files
for the 4 other hazard values. The only thing you must
change is the name of the hazard category in substeps
d), e) and f).

When done you may drag and drop all the layer files from
the Catalog window into ArcMap.

Summarize segment lengths by categories

Summarize segment lengths by categories. If you want
to summarize the lengths of the different hazard codes
along the coastline open your specific layer’s attribute
table (for example Ecosystem Disruption), right-click the
field name for the category with the same name as your
layer, select Summarize, expand the Coastline Shape_
length field, check Sum, specify a proper name (like
EcosystemDisruptionLengths.dbf — for the filename omit
any blank spaces) and location for your output and press
OK, see Fig 22, click Yes to add the results to your Table of
Contents, right-click it when it appears there and select Open
to display the summarized lengths, see Fig 23.

Coasine Shape_Length
Meamrs
[ Mmarmm
Average
o S
Sarga Deemen
Wanarce

Fig. 22. Summarizing the
length of coastlines with
different hazard levels.

AWOLD:

Fig. 23. The display of the
summarized lengths.
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Create layouts from the layers

To produce layouts of your individual layers in ArcMap first
make sure that the only layer displayed in ArcMap is the layer
in question and the basemap. Next, click the tiny Layout View
icon in the lower left section of ArcMap’s Data Frame (the 2™
from the left) a@ =,
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Next, click the upper right corner mark and reduce the map’s
size like shown in Fig 24.

a) Insert a map title: From ArcMap’s top main menu select
Insert -> Title, enter a suitable title and press OK. If you
want to enlarge the title double click it, click the Change
Symbol button and increase the size.

b) Insert a north arrow: From ArcMap’s top main menu
select Insert -> North Arrow, select a suitable one, click
Ok and move it to a position in the lower left corner.

c) Insert a scale bar: From ArcMap’s top main menu select
Insert -> Scale Bar, select a nice one, enter the Properties
and set the scale unit to either Km or Miles and press OK.
Move the scale bar to the right of the north arrow.

4) Insert a legend: From ArcMap’s top main menu select
Insert -> Legend. In the Legend Wizard remove legend
items by selecting them in the right pane and click the
< button until only the layer name appears for the Legend
Items, see Fig 25. Click Next, change the ‘Legend’
name, click Next 4 times to insert the first version of the
legend. Move it to the bottom right of your map. In order
to remove legend entries that don’t occur right click the
legend, enter the Properties, select the Items tab, check
‘Only display classes that are visible in the current map
extent’ and press OK. Now, your map should look like
Fig 26.

For each hazard layout, it is very important to remember to
change the heading and legend name so it matches the
correct hazard type. Also, it is recommended to double-check
that no mix-up of the different hazard types has been made.

Fig. 24. Reducing the
map size by clicking
the mark in the upper
right corner.

Fig. 25.

Removing legend
items that should
not be displayed.

Ecosystem disruption

B cogy #1em disrupbon haand

YT —
s
=5

Fig. 26. Final layout of the
hazard map.

Exporting layers to a PDF file

To export a map to a PDF file select File -> Export Map, select
the map’s resolution (default is 600 dpi), select PDF as file
type, locate the folder where you want to save the file, name it
and click Save.

Conversion of layers in ArcMap to Google KMLs

The conversion of ArcMap layers to Google KMLs is very
straightforward. What gets converted is the symbology for
your layers, and the attribute values for the segments along
the coastlines will popup when clicked. Thus, assuming that
you've added some symbology to your features the next step
is to locate and open the Layer to KML tool.

Before you start the conversion please make sure that you
have Google Earth installed on your desktop.

1) In ArcMap’s main menu select Windows -> Search.
A window opens and in the search field enter: Layer
to KML

Hit the Search icon and from the returned list select Layer
to KML (Conversion) (tool) by double clicking its name to
open the tool.
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2) Hit the tiny drop down arrow in the right side of the layer
specification and select your CHW layer. Next, enter
the name of the KML output file and its destination by
clicking the yellow folder icon. Finally, make sure that

the ‘Clamped features to ground’ setting is checked to
ensure that the converted KML features are inserted don’t
respect elevation settings in Google Earth. When done
press OK to establish the KML files, see Fig 27.
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Fig. 27. Conversion of the
layers to Google KMLs.

3) Minimize ArcMap by hitting the dash in the upper right
corner of the application ]SS |

4) Open Google Earth, go to the main menu, select
File -> Open, locate the KML file you created in step 2
and open it. When loaded Google Earth will zoom to the
layer’s extent. No matter which spatial reference system
you may have entered when you created your feature
class in ArcMap, the layer presented in Google Earth is
displayed in a spherical coordinate system (notice the

latitude and longitude displayed in the lower right corner
in Google Earth).

5) Now, zoom into your layer and click on some part of the
coastline. A popup window displays your CHW values,
see Fig 28.

When all hazard layers are loaded in Google Earth, it is
important to be aware of which layer is activated when used
for planning.
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Fig. 28. KML file and
popup window with
CHW code and hazard
values displayed in
Google Earth.
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4.2. APPLICATION EXAMPLES

The CHW has been applied for complete multi-hazard- of Djibouti’s coastline and as part of this project similar maps
assessments in selected regions using ArcGIS as described were developed for gradual inundation, salt water intrusion,
above. Fig 29 shows an example from the application of the erosion and flooding. Furthermore, hazard layers were
preliminary CHW 2.0 on the Republic of Djibouti. The figure developed for Google Earth that allowed users to zoom in on
shows the hazard of ecosystem disruption for the full length specific coastal stretches and hazard hotspots.

Ecosystem Disruption Hazards, Djibouti

ek 3

Fig. 29. National hazard
map for the Republic
of Djibouti showing the

' H dcl hazard of ecosystem
N OZOLr asses High disruption (Rosendahl
A 0 o 20 30 40 50 = '9 Appelquist and
km —— Moderate —— Very high Balstrem 2014)
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Fig 30 shows an example from the application of the CHW maps for northern Karnataka, displaying the hazards
1.0 for a multi-hazard-assessment of the Indian state of of erosion and flooding (Rosendahl Appelquist and
Karnataka. The example shows two sub-regional hazard Balstrgm 2015).

Coastal hazard maps for northern Karnataka

‘.‘.\\f

L

Erosion Flooding

[
ey
‘J‘\Y
L d
+ Ankola + Ankola
X
J Fig. 30. Sub-regional
,..,-5 hazard maps for northern
I’ 3 Karnataka, India showing
N Hazard Classes the hazards of erosion
0 25 5 10 1 3 and flooding (Rosendahl
A e Miles Appelquist and

-2 =4 Balstram 2015).

Generally, a standard multi-hazard-assessment will result in a
series of hazard maps, coving the five hazard types included
in the CHW system. The hazard maps shown in Fig 29 and
Fig 30 are therefore mainly for illustration and the full range
of hazard maps developed for Djibouti and Karnataka can
be found in the related papers (Rosendahl Appelquist and
Balstrgm 2015; Rosendahl Appelquist and Balstrgm 2014).
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5 Application for identification of hazard management options

APPLICATION FOR
IDENTIFICATION
OF HAZARD
MANAGEMENT
OPTIONS

management options for a specific coastal location.

This is done using the matrix shown in Fig 31 that
displays how the most commonly used management options
apply to the different coastal environments and which hazard
types they primarily address. The included management
options can be used for mitigating one or more hazard types
and can be used in isolation or as combined measures.
It should be noted, however, that the choice of management
option depends on a range of different factors beyond
the technical effects of the management option including
project costs, durability, simplicity, flexibility over time,
availability of material, labour and equipment and the related
socioeconomic and geographical context.

T he CHW can be used for identification of relevant hazard

In the matrix, the geological layout categories Sedimentary
plain, Barrier and Delta/low estuary island are considered

together for simplification reasons, as the management
options available for these layouts are relatively similar.

The matrix is used by entering with the CHW coastal
classification code and then identifying the relevant
management options for the coastal environment in question.
References to the Catalogue of hazard management options
are provided in the second row from the top. In total the
matrix includes 24 different management options, hereunder:
Beach nourishment, Breakwaters, Cliff stabilization, Coastal
setbacks, Coastal zoning, Dikes, Dune construction/
rehabilitation, Ecosystem based management, Floating
agricultural systems, Flood mapping, Flood proofing,

Flood shelters, Flood warning systems, Fluvial sediment
management, Ground water management, Groynes, Jetties,
Land claim, Managed realignment, Revetments, Sea wall,
Storm surge barrier/closure dam, Tsunami warning system
and Wetland restoration.

In total the matrix
includes 24 different
management

: question.
options,

The matrix is used by entering
with the CHW coastal classification
code and then identifying the
relevant management options
for the coastal environment in
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codes in the far left column and moving horizontally to identify relevant management options. Reference to the Catalogue of hazard management

Fig. 31. Matrix of hazard management options for the different coastal environments. It is used by entering with the CHW coastal classification
options is provided in the second row from the top (modified from Rosendahl Appelquist and Halsnaes 2015).
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5 Application for identification of hazard management options

If any of the hazard management options listed in the

matrix have been implemented at a coastal location, it can
be assumed that the hazards they primarily address are
reduced. However, as the hazard reduction effect of the
different management options strongly depends on their
specific design, quality and implementation, it is not possible
to determine the exact level of hazard reduction. The intention
of the management sections is therefore mainly to give

an overview of the relevant management measures for a
particular coastal site and their technical characteristics

and not to provide information of the exact level of hazard
reduction of a particular management option.

When deciding on the hazard management options to
implement at a specific coastal site, it is important to make
use of the broader coastal planning approaches available.
This is to ensure that the interests of all coastal stakeholders
are taken into account and the interaction between societal

activities and natural processes takes place with a minimum
of negative effects.

The concept of Integrated Coastal Zone Management (ICZM)
and the related concept of Integrated Water Resource
Management (IWRM) are well-tested approaches to tackle
these challenges and can be used to decide on the optimal
use of the coastal resources and management measures.

In many cases it can be beneficial to apply the two concepts
together, as the coastal and riverine resources and processes
are closely linked.

The core component of ICZM is to ensure a structured
coordination of coastal activities and resource demands in
order to achieve economically, environmentally and socially
sustainable development in compliance with local, regional
and international goals (Mangor 2004). The core aims of
ICZM are described further in Box 1 below.

+ To manage coastal zones in a sustainable and informed fashion which accounts for the wide range of

important factors in coastal decision-making

+ To promote compatibility and balance of coastal uses

+ To promote cooperation between departments, ministries or agencies which have control over
specific aspects of the coast. Also, to promote cooperation with other formal institutions such as

universities and user groups

+ To apply preventative and precautionary approaches in respect to coastal development. |.e. attempt

to limit coastal development in unsustainable areas

+ To account for both the economic and environmental costs and benefits of coastal management
strategies in order to ensure the most beneficial use of the coastal zone

+ To facilitate communication with all interested parties on coastal planning and decision-making
processes to ensure that all viewpoints are considered

+ To ensure the scope and complexity of the climate change issues selected as priorities for adaptation
measures are appropriate to the capacity of the institutions involved

Box 1. Aims of ICZM (Zhu et al. 2010).

The ICZM and IWRM can be easily combined with more
traditional spatial and sector planning approaches to
ensure proper integration of spatial and sector interests
and appropriate coordination between all involved
authorities and stakeholders. The holistic thinking of ICZM
and IWRM can thus be a valuable addition to traditional
planning approaches.

For implementation of an appropriate hazard management
strategy, it will in many cases be relevant with a portfolio of
hazard management measures. Furthermore, it is critical to
establish a process for monitoring and revising the strategy
over time as coastal management is an ongoing process.
This includes considering the flexibility of the strategy over
years to decades and the possibility of future adjustments.
If this is done in the context ICZM, the interrelation between

societal and natural conditions, the interests from different
coastal users and the short and long term perspectives will
be taken properly into account.

One should be aware that some hazard management

options come with a range of co-benefits while others can
have negative effects on other hazard types. It is therefore
important to properly weigh the pros and cons of the different
management options. An example of co-benefits could be the
multi-sector gains from an Ecosystem Based Management
approach, while some types of hard protection measures for
erosion and flood control have negative effects on the natural
coastal dynamics and ecosystems.
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The Catalogue of hazard management options is available

as an annex to this publication and includes descriptions

of the 24 hazard management options commonly used
worldwide. The descriptions of management options are
sorted alphabetically and include protection, accommodation
and retreat options, as well as options used for more

general hazard management. The descriptions follow the
same format and should provide an easily accessible

introduction to the main technical aspects and applications
for each option. The intention is that the CHW is used as a
key for identifying the relevant management options and
subsequently the catalogue can be used for acquiring further
technical information.

Beach nourishment with Trailing Suction Hopper Dredger (Photo:

Rohde Nielsen).
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6 Application as a standardized coastal language

APP;

“l\‘ '

:~ATION AS

A STANDARDIZED
COASTAL LANGUAGE

language to describe the conditions at a given coastal

location. This is done by combining the CHW coastal
classification codes with codes for land use and implemented
hazard management measures.

T he CHW system can be used as a standardized coastal

The codes for land use are based on the EU LUCAS
categories to facilitate compatibility with international
statistics. The coding is displayed in Table 8 and can either
be determined based on observations in the field/Google
Earth or on more complete statistical information. If relevant,
the complete detailed EU LUCAS coding can be used
(Eurostat 2015).

Land use Standardized code
Agriculture U110
Forestry ui20
Aguaculture and fishing U130
Mining and quarrying U140
Energy production U210
Industry and manufacturing U220
Transport, communication networks, storage, protective works usi1o
Water and waste treatment U320
Construction U330
Commerce, finance, business U340
Community services U350
Recreational, leisure, sport U360
Residential U370
Unused U400

Table 8. Standardized land use codes based on the EU LUCAS main categories.

The codes for implemented hazard management measures
are displayed in Table 9. Since the quality of the hazard
management measures is essential for their hazard mitigation
function, the coding includes four quality levels that should be
estimated by the user.
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Hazard management measures Standardized code

Beach nourishment BE
Breakwater BR
Cliff stabilisation CL
Coastal setback CS
Coastal zoning Ccz
Dike DI

Dune construction/rehabilitation DU
Ecosystem based management EC
Floating agricultural system FA

Flood mapping FM
Flood proofing FP

Flood shelter FS

Flood warning system FW
Fluvial sediment management FU
Groundwater management GM
Groyne GR
Jetty JE

Land claim LA
Managed realignment MA
Revetment RE
Sea walll SE
Storm surge barrier/closure dam ST
Tsunami warning system TS

Wetland restoration WE

User defined Write full word

Quality level of hazard management measures

No information 0
Low 1
Moderate 2
International state of the art 3

Table 9. Standardized codes for hazard management measures and quality level.

The standardized language obeys the following format with
the codes from Table 8 and 9:

CHW coastal classification code: Land
use, Hazard management measure-
Quality level

If several land use activities or hazard management measures
are present at a coastal location, several codes can be

MANAGING CLIMATE CHANGE HAZARDS IN COASTAL AREAS - MAIN MANUAL 36

added after each other, using the same format and
comma-separation. This is illustrated for the coastal locations
Labutta town, Lagos CBD and Miami Beach below. Since
some land use categories may be of minor importance at

a particular coastal site, it is up to the user to determine

the main activity(s) that should be listed. In some cases it
may also be relevant to include additional information in

the coastal code, such as specific hydro-meteorological
conditions. In that case, this information can be added after
the main code.




6 Application as a standardized coastal language

It should be noted that the hazard values displayed in the recommended hazard management measure is implemented
CHW do not take possible hazard management actions at “moderate” to “international state of the art” quality,

into account, as their specific effect is surrounded by one can assume that the hazards it is designed to address
great uncertainty depending on design. However, if a are reduced.

‘ Fig. 32. Labuita town,
‘ Myanmar: DE-21: U130,
: U370, FW-1 (Photo:
Axel Drainville 2014,
CC BY NC).

Fig. 33. Lagos CBD,

‘ Nigeria: TSR: U310,

‘ U340, U370, FW-2,
JE-3, LA-3 (Photo: Roy

| Luck 2005).

Fig. 34. Miami Beach,
USA (outer coastline):

1 BA-1: U310, U340, U360,
U370, BE-3, FW-3, TS-3
(Photo: Marc Averette
2008, CC BY-SA).
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7 CONCLUSION

CHW system for practical multi-hazard assessment,

multi-hazard-management and as a standardized coastal
language. The procedures outlined in the publication should
be applicable on virtually all coastlines worldwide and can
be used to improve the decision-base for coastal authorities
and planners globally, hereunder in areas with limited data
availability. If any of the hazard management options listed
in chapter 5 and 6 have been implemented properly at a
coastal site, it can be assumed that the hazards they primarily
address are reduced. However, as the hazard reduction effect
of the different management options strongly depends on
their design, quality and implementation, it is not possible to
determine the exact level of hazard reduction for a specific

T his publication provides guidance on how to use the

management option. The hazard profiles of the CHW should
therefore be seen as the hazard profile of a specific coastal
environment that can then be reduced with different hazard
reduction measures. Because the overall goal of the CHW is
to provide a universal decision support system that can be
used in areas with limited data availability, the system involves
a trade-off between simplicity and accuracy.

Hence, it is recommended to use the CHW as a coastal
multi-tool that can be supplemented with more detailed

data collection, modelling and engineering calculations in
locations where it is considered relevant. It is the hope that
the CHW will provide coastal decision-makers with a new and
useful tool for tackling the challenges from climate change
over the coming years and decades.

View of Table Mountain overlooking Cape Town, South
Africa (Photo: Sculpies/Shutterstock).
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